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A picture is worth a thousand words. This ancient saying indicates the importance of images in a document. This is precisely why a layout program must
be able to handle images with the same ease as text.
Poor images will not be improved by using this application. But, providing no
mistakes are made, this is also true the other way around.
Before we describe how to create Picture objects and import images in depth,
we think it is useful first to introduce some basic concepts of computer images
and image formats.
This knowledge may potentially save not only the amateur, but also the practised professional much time, trouble and money. If you feel comfortable with
the various image formats, you can ignore the following section and proceed
with the paragraph Creating picture objects.

Raster or Vector Images
In computer images there is a basic difference between raster images and vector images, also
known as pixel and object images. Put simply, you can say that photographs taken with a digital
camera are saved as pixel images, and such items as company logos are usually saved as vector
images.
A raster image with a size of 300 by 300 means this images is represented by 300 pixels in both
the horizontal and vertical direction. Unfortunately it is not possible to calculate the size of the
image in millimeters or inches on the basis of this information, as it is not known how many
dots or pixels occur in a unit length. This depends on the resolution of the image.
The resolution of a raster image is defined by the number of pixels per inch or centimeter. The
common measurement unit for images is DPI, or dots per inch.
An image with 72 by 72 pixels and a resolution of 72 dpi has a physical size of 1 square inch.This
is naturally a very low resolution, as generally resolutions for raster images range from 144 dpi
to 600 dpi, and even up to several thousand dpi.
The quality of a raster image is further specified by the Color Depth. This Color Depth defines
the number of available colors that a pixel may have. Simple raster images contain a single bit
per pixel which represents either black or white. Pictures with a Color Depth of 2 bits per pixel
allow 4 (22) different colors. A Color Depth of 16 Bits allows up to 65,536 (216) different colors.
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Resolution and Color Depth or bit-depth are directly related. An image with a resolution of 300
dpi and a bit-depth of 8 bits may be of poorer quality than an image with a bit-depth of 16
bits and a 200 dpi resolution.
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The enlargement factor of raster images is also problematic. If a raster image with a resolution
of 72 DPI is enlarged by 200% the image resolution decreases to 36 dpi. If the image is reduced
50% the resolution increases to 144 dpi. The amount of pixels never changes when scaling the
picture.
By contrast to raster images, vector images do not save their image information as individual
pixels but as a collection of command chains.
While with a bitmap image graphic forms consist of thousands of pixels, vector image formats
only store information about drawing the image and its attributes (line weight, color, etc.).
Vector graphics can be created with an illustration program. VivaDesigner also stores its
information about graphic elements such as objects, frames, lines and texts as vector information.
With these commands any lines, curves or text may be drawn. The advantage of vector images
compared to bitmap images is that vector information is much more efficient in storage than
pixel images.
The main advantage however, is the resolution independence of vector images. The command
to draw a circle can be drawn at the maximum resolution supported by the output device, and
is not limited by the amount of pixels.
This means you do not need to worry about the resolution or re-scaling of a vector image(e.g.
200%).

Commonly used image formats
There are hundreds of different image formats. In the professional publishing field the TIFF, EPS
and PDF image formats play a dominant role. Other formats like JPEG, or the Scitex CT format
are becoming more popular. To be able to assess which format is best for which document, you
need to have some background knowledge. We will therefore examine these formats in more
detail.
Generally you can recognise image formats by their suffixes.

Raster Image Formats
The TIFF Format
This format for raster images is very versatile and supports bit depth of 1 to 48 bits per pixel. At
the same time it supports different color models; black and white, gray scale, RGB, CIE, RGB
indexed colors and CMYK. Which color model is the right one depends on what additional work
will be done with the image. We will go into this in more detail later. The TIFF format supports
various compression methods like RLE, LZW, CCITT Group 3 and 4, and JPEG. CCITT-compression
is mostly used for transmitting images on fax machines. The desktop publishing environment
mainly uses the LZW and JPEG processes.
The TIFF format differs between images for Motorola and Intel processors. These formats are frequently called Macintosh or IBM PC format. VivaDesigner supports both variations. Images in
TIFF format have the suffix .tif or .tiff. On Mac OS X VivaDesigner recognizes an image in TIFF
format even if it has no suffix.
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The JPEG format
This platform-crossing format for raster images was developed in 1992 by the Joint Photographic
Experts Group (JPEG). What (in the jargon) is called the JPEG file format is actually the JFIF file
format, which stands for JPEG File Interchange Format. As a suffix usually .jpg (more seldom:
.jpeg or .jpe) or .jfif is used. The JPEG format is the most commonly used image format in the
Internet and in digital cameras. The advantage of the JPEG format lies in its high compression
rate, which however is not without losses. This means that the higher the compression rate, the
greater is the loss in quality. Therefore professional digital cameras store their images in either
JPEG or in loss-free, but storage-intensive RAW format. For this reason the JPEG format is only
suitable for color output of high quality layouts in a very limited way.
If possible, raster images in JPEG format should be converted to TIFF or EPS formats with the
CMYK color model.
You can however freely use JPEG images if:
- the document output will be exclusively for the monitor.
- the output is to be made on a laser printer or copier.
- a color output in exclusively composite mode is made.
If you are planning a high quality output, you should where possible avoid using JPEG images.
Should this not be possible, you should observe the following rules:
- Use JPEG images only for screenshots.
- Ensure that color raster images are supplied not in RGB, but in CMYK format. This information is supplied after image import by the Module palette or the Picture Usage. The RGB
color model has a much larger spectrum than CMYK, but RGB colors must be converted into
CMYK colors (print colors) for a color separation.
- If you or your service provider have a modern RIP, which can convert RGB data perfectly to
CMYK colors, you should ensure that you use a low compression to minimise quality losses.
- Ensure that the JPEG images have a resolution of 300DPI, insofar as the size of the image is
not reduced.
The BMP format
Windows Bitmap, BMP for short, is a file format for raster images that was developed by Microsoft for the operating systems Windows and OS/2 and was introduced with Windows 3.0. The
suffix is .bmp, occasionally .dib. Like the JPEG format, the BMP format is only suitable for
professional output in a very limited way. If possible, raster images in BMP format should be
converted to TIFF or EPS formats with the CMYK color model.
You can however freely use BMP images if:
- the document output will be exclusively for the monitor.
- the output is to be made on a laser printer or copier.
- a color output in exclusively composite mode is made.
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If you are planning a high quality output, you should where possible avoid using BMP images.
Should this not be possible, you should only use BMP images for screenshots.
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The PNG format
The PNG format (PNG stands for Portable Network Graphics) is a plat-form-crossing format for
raster images. By contrast to the JPEG format the data is saved without losses and may contain
transparency information. Despite this, the PNG format is not suitable for a professional output
due to it being limited to the RGB color model. If possible, you should convert raster images in
PNG format to TIFF or EPS formats with the CMYK color model.
You can however freely use PNG images if:
- the document output will be exclusively for the monitor.
- the output is to be made on a laser printer or copier.
- a color output in exclusively composite mode is made.
If you are planning a high quality output, you should where possible avoid using PNG images.
Should this not be possible, you should only use PNG images for screenshots.
The SCITEX formats
The application supports three image formats developed by SCITEX Corp., namely the CT (Continuous Tone) format, the LW (Linework) format and the BM (Bitmap) format.
The CT-format was developed for maximum performance on SCITEX RIPS and exposure devices.
The format is a highly compressed bitmap format, containing color-separated data, optimized
for SCITEX proprietary hardware devices.
The BM-format is a simple 256 pixel per bit screen format. This format may also contain colorseparated data. BM files are typically very compact.
The LW-format is ideally suited to black-and-white line-art scans for instance. Since it basically contains only two colors very large scans may be highly compressed and efficiently stored.

Vector Image Formats
The EPS Format
The EPS format is the most commonly used vector file format in the publishing field.
We differ between the actual EPS format (Encapsulated PostScript) with the suffix .eps and the
extended EPSF format for Macintosh with the suffix .epsf, which contains an integrated image
preview as a resource.
So that the commands to create an image on the printer for the monitor do not have to be prepared again, some vector formats save a preview of the vector image. This preview displays a
Bitmap in 72 DPI resolution which symbolises the commands or elements of the file.
The special feature of PostScript format lies in the fact that, it can contain not only vector
graphics but also raster information (as with TIFF or PICT-format). Due to the simple and brief
commands even for complex graphics there is also a higher printing speed for EPS images,
since for example in the printing of a circle not all the points in the circle, but just the command to draw a circle is sent to the printer. Therefore a vector-oriented EPS is also completely
independent of the resolution of the output device.
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The advantage of a high printing speed disappears when only a small part of an EPS image is
printed. While with different Bitmap formats in part only the visible section of the image is sent
to the printer, the program always has to transfer the whole EPS file. This is because it has no
intelligence to know which part(s) of the image make up the visible crop.
Another advantage of the EPS-format is the support of transparency. While vector images
always support transparency, the unique thing about EPS is that it also supports transparency
for raster images under certain conditions.
The EPS/DCS Format
A particular instance of the EPS format is the DCS format (Desktop Color Separation). This format is especially suited to fast color separation of EPS images and is available in two versions.
With the DCS 1.0 format an image consists of five files, a so-called Layout file consisting of a
preview and references to the other four files, which contain the appropriate CMYK representations of the EPS.
With the DCS 2.0 format an image consists of one file, which contains all the color separations
pre-separated.
DCS images also have advantages and disadvantages. The advantage of the DCS format is the
speed with which color separations can be printed. Also the DCS-1 format allows you to distribute the layout file for presentation purposes while data integrity is maintained since the preview cannot be printed with the needed high resolution without the 4 corresponding data files.
A disadvantage of using the DCS format when outputting to color printers for proofing is that
most desktop printers do not allow you to print in CMYK format. In this case the program outputs the layout file as on a laser printer.
The PDF Format
The PDF format is a document format that can save any text and images in a high quality, and
which may be displayed on and output from every operating system in high quality. Although
PDF format is not a classical image format, VivaDesigner can import PDF files into picture
objects and output them accordingly.
OPI Images
The so-called OPI images present a special feature in the use of image formats. OPI stands for
Open Press Interface and was developed in the nineties to reduce the data mass for images
when working with layout programs. OPI images are not created by an image or photographic
program, but by a so-called OPI server. This server creates low resolution versions of images in
TIFF or EPS format in the form von Layout images. The OPI server creates for example from a
20MB TIFF or EPS file an 800KB layout image. A layout image receives the same file name when it
is created. According to the server settings the layout image may receive the suffix of the high
resolution original (also .eps or .tiff) or the suffix .lay. Technically we are still dealing with
images in TIFF or EPS format, which however possess an additional commentary with the name
and path of the high resolution file. The much smaller layout images can be imported very
quickly and save memory space. In the print output later you can specify in the program if this
commentary should be included in the output, so that the OPI server can later replace the layout images with the high resolution original data.
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EPSF Vector Images and Fonts
While text is saved in raster images as a collection of pixels, the EPS format is able to save the
text and its properties as a format reference in vector images.
In order to print the text of a vector image correctly, most programs offer the possibility of
embedding the fonts used directly in the vector image (EPS or PDF). Some programs also offer
the possibility of converting the fonts used into outline paths (objects). You should only use
this option when embedding the fonts is not possible.
If fonts are not embedded or converted into outline paths, this can lead to output problems. In
this case the user must ensure that the fonts used are installed and possess exactly the same
names.
To address this problem the application shows a Font Usage, which also lists fonts needed by
imported EPS image files. Without this special Font Usage facility it would be hard for the user
to verify if fonts may be missing, which might cause problems during printing.
This is because the preview of the picture is saved as a Bitmap where type is normally displayed
as a collection of pixels. Therefore the user, in contrary to normal text in the VIVA-document,
cannot realize that the font used in the EPS might not be available.
For further explanation of this dialog please see the section entitled Font Usage.

Vector Images and Colors
When an EPS vector image is imported which contains colors not defined in the current document, the colors will automatically be added to the available colors. Adding means that the
application will take over the color name, the color definition and also the color separation
mode.
Colors that are taken into the color list through importing an EPS file can be edited with the
menu Edit/Colors, but these changes only affect objects that use these colors, but not the EPS
file which also contains the color.
Colors that are taken into the color list through importing an EPS file will remain in the color list
even if the EPS file that contains these colors has already been deleted from the document. Colors
that are taken into the color list from an EPS file can only be deleted when the appropriate EPS
file is no longer used in the document and also when other objects in the document do not use
this color.
For further explanation of this dialog please see the section entitled Color Usage.
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Creating Picture Objects
VivaDesigner is an object-oriented typesetting and layout program. This means that as with
text, images are always displayed in closed picture objects. For this reason, a picture object
must be created before the required picture is imported. The picture will be displayed within
this object.
1. Picture objects may have any arbitrary form as long as they are closed objects.
2. A new picture object is created by means of the closed object tools in Toolbar, or with shortcut keys or menu commands.
Create a new picture object interactively:
1. Choose one of the following options:
- Click in the Tool palette on the Picture Object Tool.
- Click on the arrow to the right of the tool and select a form to create your picture object.
2. Click on the document page and create the picture object.
It may be quicker if you create a picture object using the menu or shortcut keys.
Create a new picture object with menu/shortcut keys:
1. Choose one of the following options:
- Press the shortcut keys Ctrl + Shift + B (Windows/Linux) or Command + Shift + B (Mac).
- Choose the menu command Object > Content > Picture.
You can also create a picture object by converting another closed object to a picture object.
If you change a graphic object into a picture object the conversion will be immediate. However
if a text object is changed into a picture object an alert message may appear warning you that
the text will be lost.
Convert an existing object into a picture object:
1. Choose an existing closed object.
2. Choose one of the following options:
- Press the shortcut keys Ctrl + Shift + B (Windows/Linux) or Command + Shift + B (Mac).
- Choose the menu command Object > Content > Picture.
- Choose the command Content > Picture in the Context menu.
After the creation of the picture object a diagonal cross will appear, indicating the picture
object is empty.
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Summary Creating Picture Objects
- Picture objects can be created by using the Toolbar Object tools.
- Picture objects can be created automatically using the shortcut keys Ctrl + Shift + B (Windows/Linux) or Command + Shift + B (Mac) or with the menu command Object > Content >
Picture, as long as no other object is selected.
- Picture objects can be created by converting other object types.

Image Mode
Activate/Leave Image Mode
To import an image or position an imported image you will need to enable the Picture mode.
As you already know the mouse pointer will automatically change into the appropriate pointer
for the specific object type.
When the mouse pointer is positioned over a picture object it will change into the grabber
pointer.
Activate Picture mode:
Click with the mouse on the surface of a picture object.
- After the picture mode is selected by clicking in the object:
- The Picture menu will appear.
- The Module palette in Picture mode will appear if it was not specifically hidden.
- The object frame will be highlighted.This imaginary frame shows at which point the
mouse pointer will change into the object pointer with which you can select and move
the object itself.
- Hollow handles will appear. These handles indicate that Picture mode is activated and
where the mouse pointer will change into the sizing pointer through which the object can
be resized.
Note:
To select a picture object which is part of a group of objects without ungrouping all the
objects, the Group Mode must be deativated. Click anywhere on the page where there is no
Object to activate Object mode and choose the menu command Object > Group Mode Active or
press the shortcut keys Ctrl + Alt + U (Windows/Linux) or Command + Option + U (Mac).
Ways of leaving Picture Mode:
- If the picture mode is enabled and the mouse pointer is positioned on a handle it will
change into the sizing pointer. If the mouse button is held down the object can be
resized. The program will then change to Object mode.
- Click anywhere in the document where no object is present.
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- Hold down the Ctrl key (Windows/Linux) or the Command key (Mac) while clicking the
object.
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Importing Pictures
You can import pictures using a selection dialog, interactively with Drag and Drop or with the
Clipboard.

The Import Command
You can import pictures (images or illustrations) using the import dialog. The program opens
its own dialog as the default for picture import, which is identical for all operating systems.
You already know the operation of this dialog from previous chapters.
Import picture with the dialog:
1. Choose or create a picture object and activate the Picture Mode.
2. Choose one of the following options:
- Press the shortcut keys Ctrl + E (Windows/Linux) or Command + E (Mac).
- Choose the menu command File > Import.
- Choose the command Import in the Context menu.
3. Set the required display of folders and files using the options familiar to you.
4. Use the many navigation assistants to select the folder in which your picture file is stored.
5. Choose the picture file with the mouse pointer or enter the name of the picture file in the
entry field File Name.
6. You may select an option in the popup menu File Type to limit the display of picture files.
7. You may click the OS Dialog button if you prefer to work directly with the operating system
of your computer (OS = Operating System).
8. Click the Open button when you want to import the picture file you have selected.
The imported picture files will not be fully imported. While importing a picture with the Import
command the picture will not be embedded in the document. The program just saves a preview, the picture name and the required path. This keeps the size of the document within reasonable bounds.
The imported pictures have to be opened to produce the preview, then closed again so they
may be modified again immediately by other users in a network when necessary.
If you import an image in a picture object that already contains an image it will take on the
current attributes applied to the previous image. If you have modified the position or the scaling
factor of the previous picture, these parameters will automatically be applied to the new one.
If you want to import a picture into an empty picture object with certain special properties, the
parameters should be set in the Picture palette beforehand.
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Drag and Drop
Drag and Drop is a well-known technique with which you can move files and folders in the
operating system. You can use the mouse to import pictures directly from the Desktop or a
folder in the operating system.
Import pictures to existing picture objects with Drag and Drop:
1. Open the folder in the operating system.
- Make sure that both the icon of the picture file and the picture frame in the document
window are visible.
2. Click the picture file icon and with the mouse button held down, drag it over the picture
frame in the document window.
3. Release the mouse button to import the picture into the picture object.
You can also use the Drag and Drop function to import a picture and at the same time create a
new picture object. Simply drag the picture file to the document page and release it. The picture will be imported in an object with a default size determined by the program, and you can
then edit the picture and object settings in the usual way. With this method you can also
import a number of pictures simultaneously.
Import several pictures with Drag and Drop:
1. Open the folder in the operating system.
2. Mark the picture files you want to import and with the mouse button held down, drag them
to the document page.
3. Release the mouse button to import the pictures. The program will import and display them
in a default size determined by the program according to the number of pictures imported.

Clipboard
You can import pictures using the Clipboard of different programs. The clipboard is a memory
area that the operating system provides for the exchange of data between various programs. If
a picture or text is copied to the clipboard, other programs can import (paste) this data into
their documents.
By contrast to the Import command, the imported picture is embedded in the document, since
there is no file which the program could refer to during output. Therefore pictures imported via
the clipboard only have a screen resolution and are therefore not suitable for high quality
printing.

Deleting, Cutting and Copying Image Content
There are two ways to delete the content of a picture object. You can delete the picture and
leave an empty picture object, or you can import another picture into the same picture object.
To cut or copy the content of a picture object to another picture object, use the well-known
commands Cut, Copy and Paste.
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Deleting/Cutting/Replacing picture content:
1. Activate Picture Mode.
2. Choose one of the following options to delete an image:
- Press the Backspace or Delete key.
- Choose the menu command Edit > Delete.
- Choose the command Delete in the Context menu.
3. Choose one of the following options to cut an image when you want to paste the image into
another picture object:
- Press the shortcut keys Ctrl-X (Windows/Linux) or Command + X (Mac).
- Choose the menu command Edit > Cut.
- Choose the command Cut in the Context menu.
4. Choose one of the following options to replace an image:
- Press the shortcut keys Ctrl + E (Windows/Linux) or Command + E (Mac).
- Choose the menu command File > Import.
- Choose the menu command Import in the Context Menu.
Copy & Paste picture content:
1. Activate the Picture Mode in the picture object you want to copy.
2. Choose one of the following options:
- Press the shortcut keys Ctrl + C (Windows/Linux) or Command + C (Mac).
- Choose the menu command File > Copy.
- Choose the command Copy in the Context menu.
3. Activate the Picture Mode in the picture object into which you want to paste the picture.
4. Choose one of the following options:
- Press the shortcut keys Control-V (Windows/Linux) or Command + V (Mac).
- Choose the menu command File > Paste.
- Choose the command Paste in the Context menu.
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Defining the Crop
As long as there are no preference properties set for a picture object an imported picture will
be placed in the upper left corner of the picture object. However you may move the picture in
the picture object in any desired direction. To do so there are several options:
- Interactive moving with the mouse/grabber hand.
- Interactive moving with the arrow keys.
- Precise positioning by means of parameter entrances in the Picture palette.
- Precise positioning by centering the picture in the picture object.
- Skewing and rotating the picture.
- Resizing the picture object.

Moving Picture Content
The picture can be moved and aligned with the mouse/grabber hand, with the arrow keys or
with menu commands. In the default settings the picture preview will be displayed when the
picture is moved in the picture object. The preview is also shown with a frame to help with
positioning.
Move picture content interactively:
1. Activate Picture Mode.
2. Hold down the mouse button (Mac) or the left mouse button (Windows/Linux) and drag the
picture in any direction.
- Hold down the the Shift key to constrain the movement to 90 degrees horizontal/vertical.
3. Instead of the mouse, use the arrow keys to move the picture.
In all the cases described above, the current position of the preview will be displayed immediately in the Module palette (in Picture mode).
4. Alternatively, use the entry fields in the Module palette to define the top left hand position
of the preview in the picture frame. Both positive and negative values may be entered in all
units of measurement.
While moving the image interactively with the mouse/grabber hand or with the arrow keys, the
actual position is displayed immediately. This may slow down the speed of the program but
undoubtedly it enhances your control over the work.
The speed and display quality when moving pictures can be defined in the Document Preferences
for Pages & Objects.
Display options for moving pictures:
1. Choose the option Pages & Objects in the Preferences.
2. Choose one of the following options in the popup menu Move Image Content:
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- Choose the option Gray out images, when only a (blue) frame instead of a preview
should be displayed when moving a picture. This option is suitable for very slow computers.
- Choose the option Show preview in frame, when the preview should be displayed when
moving a picture. This option is activated as default.
- Choose the option Show complete preview, when the complete preview should be displayed
when moving a picture. This option is suitable for very precise picture positioning, and is
intended for very fast computers.
3. Click OK to close the dialog.
If when moving picture content you wait for a second with the mouse, the picture preview will
flicker briefly. This is a signal to the user that the program has temporarily changed the display
mode for the current movement of the picture:
- If in the Preferences the option Move Image Content has been activated, the program
behaves temporarily as if the option Show Preview in Frame has been selected.
- If in the Preferences the option Show Image Size has been activated, the program
behaves temporarily as if the option Show Complete Preview has been selected.
You can also move or align the picture preview using menu commands.
Move picture preview using menu:
1. Choose one of the following options to centre the picture horizontally and vertically in the
Picture object:
- Press the shortcut keys Control-Shift + M (Windows/Linux) or Command + Shift + M (Mac).
- Choose the menu command Picture > Alignment > Center.
- Choose the command Center in the Context menu.
2. Choose one of the following options to align the picture horizontally on the left edge of the
Picture object:
- Press the shortcut keys Ctrl-Shift + G (Windows/Linux) or Command + Shift + G (Mac).
- Choose the menu command Picture > Alignment > Left.
- Choose the command Alignment > Left in the Context Menu.
3. Choose one of the following options to align the picture horizontally on the right edge of the
Picture object:
- Press the shortcut keys Ctrl + Shift + R (Windows/Linux) or Command + Shift + R (Mac).
- Choose the menu command Picture > Alignment > Right.
- Choose the command Alignment > Right in the Context Menu.
4. Choose one of the following options to center the picture horizontally in the Picture object:
- Choose the menu command Picture > Alignment > Center Horizontally.
- Choose the command Alignment > Center Horizontally in the Context menu.
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5. Choose one of the following options to align the picture vertically on the top edge of the
Picture object:
- Choose the menu command Picture > Alignment > Top.
- Choose the command Alignment > Top in the Context Menu.
6. Choose one of the following options to align the picture vertically on the bottom edge of the
Picture object:
- Choose the menu command Picture > Alignment > Bottom.
- Choose the command Alignment > Bottom in the Context menu.
7. Choose one of the following options to center the picture vertically in the Picture object:
- Choose the menu command Picture > Alignment > Center Vertically.
- Choose the command Alignment > Center Vertically in the Context Menu.
When the image is centered in the object, an absolute value is calculated that does not change
when the height or width of the Picture object is changed.
Move picture preview precisely with the dialog:
1. Choose a Picture object.
2. Choose an appropriate option:
- Press the shortcut keys Ctrl + Alt + M (Windows/Linux) or Command + Option + M (Mac).
- Choose the menu command Object > Special.
- Choose the command Special in the Context menu.
3. Enter a value in the fields Horizontal and/or Vertical in the Offset section. Positive values
move the picture preview to the right or downwards, negative values move the picture preview to the left or upwards. The reference point is top/left.
4. Click OK to close the dialog.

Resizing Picture Object
The picture crop may of course also be determined by subsequently altering the size of the picture object. If you resize the picture object upwards or to the left the image preview inside will
follow the movement, not changing its offset inside the picture object.
Resizing a picture object:
1. Choose a picture object.
2. Resize the picture object and observe the image preview.
If however you select Crop image on all sides when stretching in the Document Preferences for
Pages & Objects, the picture remains in its position in relation to the page, and the offset within
the picture object will change.
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The command Fit Frame to Picture in the Picture menu as well as the Context menu is related to
resizing the picture object. The command causes the picture object to take the same size as the
imported image inside according to its actual scale.
Fitting the picture object to the picture preview:
1. Choose a picture object.
2. Choose an appropriate option:
- Choose the menu command Picture > Fit Frame to Picture.
- Choose the command Fit Frame to Picture in the Context menu.
The size of the picture object now corresponds to the size of the picture preview in its current
scaling. At the same time the picture preview is automatically centered in the picture object.

Summary Moving Picture Content
- You may move the image preview interactively using the mouse or the arrow keys.
- You may position the image preview exactly by entering values for the vertical and horizontal offset into the entry fields of the Module palette (Picture mode).
- You may center the image preview relatively according to the size of the picture object
using the Center command from the Picture > Alignment menu. You also may use the
shortcut keys Ctrl + Shift + M (Windows/Linux) or Command + Shift + M (Mac).
- You may position the image relatively according to its actual scale using the command Fit
Frame to Picture from the Picture menu.
- You may crop the image by resizing the picture object.
- If you resize the picture object upwards or to the left the position of the image inside will
change in relation to the page.
- If you resize the picture object upwards or to the left the position of the image inside will
not change in relation to the page if in the Document Preferences for Pages & Objects the
option Crop image on all sides when stretching is selected.

Mirror, Rotate and Skew
You can mirror, rotate and skew picture previews in picture objects.
Mirroring, rotating or skewing picture previews with the Module palette:
1. Activate the Picture mode.
2. Click the checkbox Mirror Horizontally or Mirror Vertically in the Module palette (Picture
mode) to mirror the picture.
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3. Enter an angle between -360 and +360 degrees in the entry field Rotation to rotate the picture
preview in the picture object. Alternatively, click the arrow buttons on the right of the entry
field to rotate one degree at a time. Positive values rotate the picture preview anti-clock-
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wise, negative values rotate the picture preview clockwise. The rotation occurs around the
center point of the picture preview.
4. Enter an angle between -75 und +75 degrees in the entry field Skew to skew the picture preview in the picture object. Alternatively, click the arrow buttons on the right of the entry
field to skew one degree at a time. Positive values rotate the picture preview to the right,
negative values rotate the picture preview to the left.
Mirroring, rotating or skewing picture previews with the dialog:
1. Choose a Picture object.
2. Choose an appropriate option to activate the Object mode:
- Click the object frame.
- Click on the image surface while holding down the Ctrl key (Windows/Linux) or the
Command key (Mac).
- Move the mouse over the middle of the object until the gray Object Mode Select button
appears and click once. If the button does not appear, the object height or width is too
small and you must choose another option.
3. Choose one of the follwing options:
- Press the shortcut keys Ctrl + Alt + M (Windows/Linux) or Command + Option + M (Mac).
- Choose the menu command Object > Special.
- With the mouse button held down, choose the command Special in the Context menu.
4. Click the checkbox Horizontal or Vertical in the Mirroring section to mirror the image.
5. Enter an angle between -360 and +360 degrees in the entry field Rotation to rotate the picture preview in the picture object. Positive values rotate the picture preview anti-clockwise,
negative values rotate the picture preview clockwise. The rotation occurs around the center
point of the picture preview.
6. Enter an angle between -75 and +75 degrees in the entry field Skew, when you want to skew
the picture preview in the picture object. Positive values rotate the picture preview to the
right, negative values rotate the picture preview to the left.
7. Click OK to close the dialog.
Note:
- If however while creating the document it is already determined that the image should be
rotated it is advisable to execute the action in the original illustration or drawing program. This will enhance the printing speed later on considerably.
- If a rotation in the program cannot be avoided, then a rotation without decimal places
will hardly slow down the printing speed. For diaply on the monitor this is not relevant.
- The same goes for images requiring a skew factor.

17

Working with Pictures

Scaling Image Preview
The scaling of an image may be set horizontally or vertically independently. While doing so the
original file will not be altered, only the imported image in the document will be shown and
printed with the set size. Such changes therefore have no effect on the actual image file.
Although the program allows scaling factors between 1% and 1600% of the original size, you
should give careful consideration to the picture scaling with raster images, as:
- If you enlarge a raster image considerably in the program this can result in undesired loss
of quality in the output.
- If you make a raster image considerably smaller in the program there will not be a loss of
quality, but the information sent to the output device is unnecessarily large which will
slow down the printing speed.
Vector images on the other hand may be given any scaling you like, as there will be no loss of
quality in the output.
The program offers many possibilities for changing the scaling proportionally and unproportionally:
Scaling image preview proportionally:
1. Activate Picture Mode.
2. Choose one of the following options to apply one of the default scaling factors:
- Press the shortcut keys Ctrl + Alt + 5 (Windows/Linux) or Command + Option + 5 (Mac) to
apply a scaling of 50%.
- Press the shortcut keys Ctrl + Alt + 7 (Windows/Linux) or Command + Option + 7 (Mac) to
apply a scaling of 75%.
- Press the shortcut keys Ctrl + Alt + 1 (Windows/Linux) or Command + Option + 1 (Mac) to
apply a scaling of 100% (original size), or selext the command Original Size in the Context menu.
- Press the shortcut keys Ctrl + Alt + 2 (Windows/Linux) or Command + Option + 2 (Mac) to
apply a scaling of 200%.
- Press the shortcut keys Ctrl + Alt + 4 (Windows/Linux) or Command + Option + 4 (Mac) to
apply a scaling of 400%.
- Choose a scaling factor between25% and 400% in the Picture menu.
- Choose a scaling factor between25% and 400% in the popup menus Horizontal Scale and
Vertical Scale in the Module palette (choose the same setting for both).
3. Choose one of the following options to fit the image preview proportionally into the Picture
object:
- Press the shortcut keys Ctrl + Alt + 0 (Windows/Linux) or Command + Option + 0 (Mac).
- Choose the menu command Picture > Fit Picture Proportionally to Frame.
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- Choose the command Fit Picture Proportionally to Frame in the Context Menu. With this
action the picture preview will be centered automatically.
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4. If you have a mouse with a scroll wheel, hold down the Alt key (Windows/Linux) or the
Option key (Mac) and scroll in the appropriate direction to enlarge or reduce the picture
preview in 5% steps.
- Additionally, hold down the Shift key to enlarge or reduce the picture preview in 1% steps
with the scroll wheel.
5. Use the Sliding Scale to enlarge or reduce the picture preview. Every time you release the
slider, it will be rest to the middle and the enlargement or reduction of the image preview
size will be implemented.
6. If you want to scale proportionally both the picture preview and the picture object, hold
down the keys Ctrl + Shift (Windows/Linux) or Command + Shift (Mac) while you resize the
object.
Scaling image preview unproportionally:
1. Activate Picture Mode.
2. Choose an appropriate option in the Module palette:
- Choose an entry from the popup menus Horizontal Scale and/or Vertical Scale .
- Enter a value in the field for Horizontal Scale and/or Vertical Scale. The entry fields
accept values between 1% and 1600% in 0,001% steps.
- Enter a measurement in any measurement unit in the fields Width and Height.
3. Choose an appropriate option to fit the image preview into the Picture object unproportionally:
- Choose the menu command Picture > Fit Picture to Frame.
- Choose the command Fit Picture to Frame in the Context menu.
With this action the picture preview will be centered automatically.
4. To scale unproportionally both the picture preview and the picture object, hold down the
keys Control + Alt (Windows/Linux) or Command + Option (Mac) and resize the object.
Scaling image preview unproportionally with the dialog:
1. Choose a Picture object.
2. Choose an appropriate option:
- Press the shortcut keys Ctrl + Alt + M (Windows/Linux) or Command + Option + M (Mac).
- Choose the menu command Object > Special.
- Choose the command Special in the Context menu.
3. Enter a value in the field for Horizontal Scaling and/or Vertical Scaling. The entry fields
accept values between 1% and 1600% in 0,001% steps.
4. Click OK to close the dialog.
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When the Picture palette is shown the actual scaling factors will be substituted in the entry
fields.
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It is not necessary to enter the %-mark as these entry fields are for percentages only. The program will add the %-mark automatically after entering a value.
If the picture object is an oval or a polygon, the program will calculate the scaling factor
according to the rectangle enclosing the picture object. The actual position of the image within
the object will be ignored.

Tips and Tricks with Images
VivaDesigner offers many options for steering the import, display and output of images.
Image import
- If you work with raster images in EPS or TIFF format, ensure that the image files are created
with a full size TIFF preview. In this case the program will not check through the entire file
but will just read and display the appropriate preview.
- If you work with vector images in EPS format, ensure that the image files are created with
a TIFF preview, so that the images can be displayed on all platforms.
- If a picture file has no image preview and no preview can be created by the program, a
gray surface will be displayed. At output or export as PostScript file the gray surface will
be replaced with the correct picture, providing that in the Objects tab of the output dialog the option High Resolution has been selected.
- Use the setting EPS Image Preview in the Program Preferences for Imagesto define
whether and in which quality the preview of vector images in EPS format should be displayed. The higher the quality, the longer it will take to import the image file.

Image display
- Use the setting Color Depth in the Document Preferences (Pages & Objects) to define in
which quality the preview should be displayed (8 Bit or 24 Bit). With the higher quality,
more working memory is needed.
- Use the command Quick Picture View in the View menu to define if the preview should be
switched on or off. If you click in a picture object and activate Picture Mode, the preview
will always be displayed, irrelevant of whether the command Quick Picture View is
switched on or not.
- The definition Limit image scaling to in the Document Preferences (Pages & Objects) is set
to 1024 Pixel as default. You may uncrease this, but you must be aware that the higher
the value, the more working memory (RAM) will be required. Any change to the setting
will only take effect on newly imported images in the document.
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